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File menu commands
The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear 

printed.
Print Setup Selects a printer and printer connection.
Settings Set default settings for Label Wizard.
Exit Exits Label Wizard.



Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the 

clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Select All Select the entire document.
Find... Find the specified text.
Replace... Replace specific text with different text.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Panel menu commands
The Panel menu offers the following commands; which enable you to change the 
characteristics of the text contained within the active panel.

Fonts... Open the Font dialog box for the active panel.
Enlarge Font Enlarge the font size of the active panel one point.
Reduce Font Reduce the font size of the active panel one point.
Style Select all font formatting.
Color... Set the active panel's text color.
Align Align the text within the active panel.
Margins... Set the active panel's margins.
Hide Text Hide the text of the active panel.
Paragraph Mode Toggle between list and paragraph mode.
Clone... Copy panel fields to duplicate panels.

Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Horizontal Arranges windows in non-overlapped tiles.
Tile Vertical Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Next Pane Switch to the next window pane.
Window 1, 
2, ...

Goes to specified window.



Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get
help.

Using Help Provides general instructions on using help.
About Displays the version number of this application.



New command (File menu)
Use this command to create a new document in Label Wizard.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box
This dialog box has a listbox filled with all the labels contained in the default label template.  
At the bottom of the dialog box is the description of the currently selected label in the listbox
and the name of the current label template file.

To open another template file then select the Open Template button.    This will open the 
Open Template dialog box.

To make that template file the default template file, then select the Set As Default button.   
The next time the File New dialog box appears it will contain the labels of that label template
file.



Open Template dialog box
This dialog box works just like the File Open dialog box.    At the bottom of the dialog box is 
the name of the template file and its description.



Open command (File menu)
Use this command to open an existing document in a new window.    Label Wizard displays 
the File Open dialog box to allow you to choose the existing document.    Label Wizard allows 
you to have more than one open document.    Use the Window menu to switch among the 
multiple open documents.    See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Label Wizard Label    (*.lwl)
All Files (*.*)

Drives
Select the drive in which Label Wizard stores the file that you want to open. 

Directories
Select the directory in which Label Wizard stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close all windows containing the active document.    Label Wizard 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, Label Wizard displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)
Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Label Wizard displays the Save As dialog box so you 
can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active document.    Label Wizard displays the Save 
As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Label Wizard adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Settings command (File menu)

Use this command to set the default values for the following:

Printer Margins
Default Font
Default Colors



Printer Margins command (File menu)
Use this command to display the Printer Margins dialog box.    Do not change the zero 
settings and Software mode unless you cannot get the test label to print properly.

The meaning of the offset fields of the dialog box depend on the selected mode.    Set the 
mode to Hardware if you know for sure the printer hardware margins (margins the printer 
cannot physically print to).    When the mode is set to Software, as long as the printer 
margins are set to its hardware margins the offset should be zero.    If it is not then you can 
use the offset to correct your printer margins.

Troubleshooting:
There is a test template included with Label Wizard.    With the mode set to Software and the 
offset to zero, print the absolute test box in portrait and landscape mode.    If the absolute 
test box is not accurately placed, measure the box's distance from the top and left of the 
page.    If you subtract the distance your box is from the edge of the page from what it 
should be (two inches), you get the values for the offset.    If you have no problem with 
Software mode and zero offset then the relative test box will print to the hardware margins.   
You can use the distance of that box from the edge of the page as the hardware margins. 

There should be no problem with Software mode and zero offset as long as the printer 
margins are not changed and are set to the hardware margins.    Only use Hardware mode if 
you only use one printer and you tend to change the printer margins frequently.    Hardware 
mode can compensate for a change in user margins, but the printing area will be decreased 
and you may experience partial printouts.



Printer Margins dialog box
There is a choice between two modes:    Software and Hardware.
Software mode uses the offset as a correction factor for the currently set margins.
Hardware mode uses the offset as the absolute hardware printer margins from the top-left 
corner of the page.

The units used for the offset are 0.01 inch.    That is to say 100 units equals 1 inch.

For a more lengthy discussion on Software and Hardware mode see Printer Margins.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)
Use this command to end your Label Wizard session.    You can also use the Close command 
on the application Control menu.    Label Wizard prompts you to save documents with 
unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)
Use this command to reverse the last editing action, if possible.      The Undo command is 
unavailable if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)
<< Write application-specific help here. >>



Cut command (Edit menu)
Use this command to remove the currently selected data from the Edit Pane and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Label Wizard, such as File Open.    A check mark appears next to
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Label Wizard,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    Label Wizard displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, Label Wizard displays the Save As dialog box.

Print preview the active document.

Print the active document, bypassing the Print dialog box.

Remove the selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Open the Font dialog box for the active panel.

Increase the size of the active panel's font by one point size.

Reduce the size of the active panel's font by one point size.

Toggle bold formatting of the active panel's font.

Toggle italic formatting of the active panel's font.



Toggle underlining of the active panel's font.

Left align text within the active panel.

Center align text within the active panel.

Right align text within the active panel.

Set the active panel's left and right margins.

Hide the text of the active panel.

Toggle between list mode and paragraph mode.

Display Label Wizard's about box.

Obtain context sensitive help.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Label Wizard window.    To display or hide the
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Fonts command (Panel menu)
Use this command to display the Font dialog box.    The Font dialog box allows you to change
the font of the active panel.

Shortcut

Toolbar:



Enlarge Font command (Panel menu)
Use this command to enlarge the font size of the active panel by one point size.

Shortcut

Toolbar:



Reduce Font command (Panel menu)
Use this command to reduce the font size of the active panel by one point size.

Shortcut

Toolbar:



Align command (Panel menu)
Use this command to select the text alignment within the active panel.

Command Action Shortcut
Left left align text

CTRL+L
Center center align text

CTRL+E
Right right align text

CTRL+R



Paragraph Mode command (Panel menu)
Use this command to toggle between list mode (default) and paragraph mode.

Shortcut

Toolbar:

Explanation of List mode and Paragraph mode:

                    List mode implements word-wrap by indenting the word wrapped lines.    This is the
default mode for each panel.    Space characters after each line of text in the Edit Pane are 
disregarded when displayed in the panel.    If you want to include spaces after a line of text I 
suggest you add character 160 to the end of the line.    This is accomplished by holding down
the ALT key and typing 0160 on the numeric keypad.
                    Paragraph mode implements a normal word-wrap.    Each line of text in the Edit 
Pane is displayed as the next sentence in the panel.    Two spaces are placed in between 
each sentence (line of text you type in the Edit Pane) in the panel.    Paragraph mode allows 
you to type out paragraphs of text.    In paragraph mode, no space is disregarded, linefeed 
and carriage return characters (those invisible characters at the end of each line) are turned 
into spaces and \n is used to start a new line.

The first two sentences of these two paragraphs would look like this in the Edit Pane:

                    List mode implements word-wrap by indenting the word wrapped lines.
This is the default mode for each panel.\n
                    Paragraph mode implements a normal word-wrap.
Each line of text in the Edit Pane is displayed as the next sentence in the panel.



Color command (Panel menu)
Use this command to set the color of the text within the active panel.    Label Wizard displays
the Color dialog box for your input.



Margins command (Panel menu)
Use this command to set the margins for the text within the active panel.    Label Wizard 
displays the Margins dialog box for your input.

Shortcut

Toolbar:
Keys: CTRL+M



Margins dialog box
This dialog box allows you to adjust the margins for the active panel.    The units are 
equivalent to 1/32 of an inch.    A value of 32 would provide you with a margin of one inch.    
The maximum margin size is 320 units or 10 inches.    The combined left and right margin 
cannot be greater than the width of the panel.    The combined top and bottom margin 
cannot be greater than the height of the panel.    You can reset the margins by hitting the 
Clear button.



Style command (Panel menu)
Use this command to select the font's style for the active panel.

Command Action Shortcut
Regular unselect all font 

formatting
F5

Bold toggle bold formatting
CTRL+B

Italic toggle italic    formatting
CTRL+I

Underline toggle underline 
formatting CTRL+U

Strikeout toggle strikeout 
formatting



Hide Text command (Panel menu)
Use this command to hide the text of the active panel.    This will prevent the text from 
printing and appearing in print preview.    The text will be displayed using the inactive color.

Shortcuts

Toolbar:
Keys: CTRL+H



Clone command (Panel menu)
Use this command to quickly copy the active panel's fields to duplicate panels.    Label 
Wizard displays the Clone dialog box for your input.



Clone dialog box
The Clone dialog box allows you to choose the following commands, which enable you to 
quickly copy the active panel's attributes to duplicate panels.    Duplicate panels are panels 
that share the same name, because they share the same functionality.

Panel:
Font Copy font to duplicate panels.

font name, size and style
Text Copy text to duplicate panels.
Attributes Copy attributes to duplicate panels.

panel margins
panel mode (Paragraph or List)
panel alignment (Left, Center or Right) 
panel hidden text property.

Sequence Expands the Clone dialog box    to accomodate sequencing.

Direction:
Both Clone to every panel in the path.
Forward Clone to every panel in the path that follows the active 

panel.
Reverse Clone to every panel in the path that precedes the active 

panel.

Path:
Label Restrict cloning to the whole label.
Row Restrict cloning to the current row (across).
Column Restrict cloning to the current column (down).



Clone Sequence (Clone dialog box)

Use this feature to easily insert a sequence of numbers into your label document.

In the Replace edit box enter the text you want replaced with a number sequence.    Enter 
the initial value in the Starting with edit box.    The text you entered in the Replace edit 
box may appear more than once in a panel.    You have the option to increment your 
sequence once per panel (Each Panel) or with every instance (Each Instance) of the 
replace text.    Enter the amount your sequence is incremented/decremented by in the 
Increment by edit box.

Tips:
1. Make the replace text a combination of characters that do not normally appear in your 

panel text.    For example:    %1,#1#,~1~.
2. You can clone text and sequence at the same time.    First the text is cloned and then 

sequencing is applied to that text.
3. Your sequence will be incremented with a positive value in the Increment by edit box 

and decremented with a negative number in the Increment by edit box.
4. If you don't want to increment    the sequence number, then enter a 0 in the Increment 

by edit box.



New command (Window menu)
Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)
Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)
Use this command to arrange multiple opened windows side by side.



Arrange Icons command (Window menu)
Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)
Label Wizard displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Label Wizard and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of Label 
Wizard.

Shortcut

Toolbar:



Context Help command 
Use the Context Help command to obtain help on some portion of Label Wizard.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Label Wizard window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcuts

Toolbar:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the Label Wizard window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)
Use this command to switch to the next open document window.    Label Wizard determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)
Use this command to switch to the previous open document window.    Label Wizard 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Label Wizard application window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Font dialog box

The following options allow you to specify the font you want to use:
Font

Type or select the font you want to use.    This box lists all the screen fonts you currently 
have installed on your system. 

Font Style
Select the style of font you want to use.

Size
Select the point size of the font.    A point is 1/72 of an inch.    You are restricted to a point 
size between 2 and 360.

Effects
Select strikeout or underline formatting for the font.

Color
Select the color of the font.



Color dialog box
You can adjust the current color of the active panel, inactive panel or the active panel text 
with this dialog box.

When adjusting the color of the active or inactive panel, make sure that you do not select 
the same color for both, it will only make things confusing.    The default colors are red for 
the active panel and blue for the inactive panel.



Find command (Edit menu)
Use this command to search the Edit Pane for a specific string.    Label Wizard displays the 
Find dialog box  as a response to this command.



Find dialog box

The following options are available:
Find What

Type the text you want to find.
Match Case

Select to match capitalization exactly.
Find Next

Click to search for the next instance of the search text.



Replace command (Edit menu)
Use this command to replace a specific string with a different string in the Edit Pane.    Label 
Wizard displays the Replace dialog box  as a response to this command.



Replace dialog box

The following options are available:
Find What

Type the text you want to find.
Replace With

Type the text you want to replace the found text with.
Match Case

Select to match capitalization exactly.
Find Next

Click to search for the next instance of the search text.
Replace

Click to replace the highlighted found text.
Replace All

Click to replace all instances of the found text with the replace text.



Select All command (Edit menu)
Use this command to select all the text contained within the Edit Pane.



Next Pane command (Window menu)
Use this command to switch to the next pane.

Shortcut
Key: F6.



Split command (Window menu)
Use this command to activate the split bar between the Edit Pane and the Label Pane.    This 
allows you to resize the relative size of the two panes with the keyboard.    You can also use 
the mouse to select the split bar and resize the relative size of the two panes.



Modifying the Document
<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





Print command (File menu)
Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.    The toolbar button bypasses the Print dialog box.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog
The Printing dialog box is shown during the time that Label Wizard is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)
Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The Print Preview toolbar 
offers you options to zoom in and out of pages; and initiate a print job.

Shortcut

Toolbar:



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)
<< Write application-specific help here. >>





Overview

Welcome to Label Wizard.    Label Wizard is an all purpose label utility program.    With
Label Wizard you will be able to create any type of label you desire.    The program is only 
limited by the label template files you have.    Included in the registered copy is a file 
describing the Label Wizard Template language called LWTLANG.WRI.    By reading 
LWTLANG.WRI and examining the template files included you should be able to create your 
own template files.    To get the most out of this software I do suggest that you go through 
the Guide to Label Wizard.

See also... 
Register Label Wizard

Statement of Disclaimer
Frank A. Pellegrino, the author of Label Wizard, hereby disclaims all warranties 

relating to this software, whether expressed or implied, including without limitation any 
implied warranties of merchantability or fitness for a particular purpose.    The author will not
be liable for any special, incidental, consequential, indirect or similar damages due to loss of
data or any other reason, even if the author or an agent of the author has been advised of 
the possibility of such damages.    In no event shall the author's liability for any damages 
ever exceed the price paid for the license to use the software, regardless of the form of the 
claim.    The person using the software bears all risk as to the quality and performance of the
software.



What's New:    Version History

Version 2.3

Added color support for text.

Fixed a printer margin bug in version 2.2.

Version 2.2

The Panel menu has changed again.

Cloning capabilities have been expanded.    You can now also insert a sequence in your 
document.

The Print button on the toolbar now bypasses the print dialog box to quickly print your 
document.    Label documents now store their orientation.    Files created with old template 
files will default to the current printer orientation.    Files created from the new templates will 
automatically change the printer's orientation when printing.

Prevent text from being printed with the Hide Text feature.

Zoom in/Zoom out with the right mouse button clicked on non-panel areas in the Label Pane. 
Delete the active panel's text with the delete key.

New Font dialog box and improved use of font resources.

Dialog boxes to change default settings.

Version 2.1

You can now double click on a panel, and the Edit Pane becomes active for immediate 
editing.

You now have complete control over margins in each panel.

In the New dialog box the Open Template button now opens up in the directory that the last 
default label template was located.

You can adjust the printer margins for accurate printing.

New file format.

Version 2.0a

Interim release with a few bug fixes.

Version 2.0

The Panel menu has changed and the Clone menu has been added.

You now have a right mouse button menu for the Edit Pane and a CTRL right mouse button 
information menu for the panels.



Most importantly you have the ability to create your own template files (read LWTLANG.WRI 
included in the registered version) and the ability to work with different types of labels.

Version 1.0

First publicly distributed version of Label Wizard.



File Format Changes

Label Wizard registered version can read older files, but they will not work properly 
with the newer features.    Older files will not clone properly when cloning of rows and 
columns becomes available.    The document margins of files older that Label Wizard v2.1 are
all relative.    Old files that were made for precision labels like a mailing label or floppy label 
may not print properly.



The Document Window

Label Wizard's document window is split into two panes.    The top pane is the Edit 
Pane.    The bottom pane is the Label Pane.



Edit Pane

The Edit Pane contains the text of the active panel.    To select the Edit Pane you must
click your cursor within the Edit Pane or double click in the active panel.    You can use the 
Edit menu commands to edit the text in the Edit Pane.    As you type text into the Edit Pane, 
the active panel is updated.

With the right mouse button clicked within the Edit Pane, you can pull down a 
compact pop-up version of the Edit menu.    You can select the menu items with either the 
left or right mouse button.    To cancel the pull down menu you can either press the <ESC> 
key or click outside the menu with the left mouse button.

See also...
Label Pane



Label Pane

The Label Pane contains the view to your Label Wizard document.    It is from this 
pane that you can examine the layout of your label.    You also use this view to navigate 
through your label.

MUST SEE:
What exactly is a label?



What exactly is a label?

In Label Wizard, a label is a collection of text panels and borders.



Panels

Panels are the rectangular dotted boxes that hold your text.    You can only edit one 
panel at a time.    This panel is the active panel.    You can change the text it contains by 
editing it in the Edit Pane.    You can change the appearance of the panel's text by using the 
command in the Panel menu.

Navigation
To select a panel (make it the active panel), you click on it with the left mouse button,

within its boundaries.    The area you click within, to activate a panel, is its selection 
boundary.    Some panels have a restricted selection boundary.    This restricted boundary is 
called a hotspot.    To select panels with a hotspot you must click within the hotspot's 
boundary.    Hotspots allow overlapping panels to have a unique selection boundary.    
Hotspots usually appear as smaller rectangles within a panel.

With the right mouse button clicked within a panel's selection boundary, you can pull 
down a compact pop-up version of the Panel menu.    You can also select a panel with the 
right mouse button.    You can select the menu items with either the left or right mouse 
button.    To cancel the pull down menu you can either press the <ESC> key or click outside 
the menu with the left mouse button.

If you hold down the CTRL key and press the right mouse button an information menu
will pop up.    Contained within the information menu is the current panel's name, the font 
and point size, and the margin settings.    Use the information menu to to save time from 
invoking the Font dialog box and Margin dialog box just to find out the settings.    You should 
also take note of the panel's name.    Panel's with the same name are duplicate panels.    The 
Cloning function can operate on those members.

If you click the right mouse button outside of a panel, the label pane will toggle 
between zoom in and zoom out.    You can also delete the text of the active panel with the 
delete key.



See also...
Borders



Active Panel

When you start a new label or open a previously saved label, the first panel is made 
the active panel.    The active panel is the one that is affected by all the Panel menu 
commands.

In Label Wizard's default settings, the active panel is the red panel.    The inactive 
panels are the blue panels.

See also...
Changing the Default Colors
Changing the Default Font



Borders

Borders are the lines and boxes that form the boundaries of your label.

See also...
Panels



Changing the Default Colors

You will be able to adjust the color of the active and inactive panel with a Color dialog box.    
You must make sure they are different.

See also:
Settings command.



Changing the Default Font

You will be able to adjust the default font with a Font dialog box.

See also:
Settings command.



Registering Label Wizard

Label Wizard is user supported (SHAREWARE) software and is not free.    Users may 
evaluate Label Wizard for a maximum of 30 days, after which a registration fee must be 
paid, or Label Wizard should be deleted from your system.    You are free to give out copies of
the shareware version of Label Wizard and are encouraged to do so, so long as the following 
files are contained in the archive:

LABELWIZ.EXE
LABELWIZ.HLP
README.1ST
********.LWT initial label templates (audio cassette (J-Card) label...)
********.LWL        sample files
SAMPLES.TXT          
FILE_ID.DIZ 

Registering Label Wizard enables and encourages the author to continue upgrading 
this program.    Registered users will no longer see the introduction dialog box.    Registered 
users also receive the latest registered version of Label Wizard in their choice of diskette 
size, notices of future updates when they become available, and extended product support.   
In the registered version you also get the documentation to create your own label templates 
and a program to facilitate the editing of label templates.    To register just fill out the 
Registration Form.



Direct Order Discount
When you order by credit card or CompuServe's Software Registration Service the cost of 
Label Wizard is $30.    If you order directly from the author you save $5.



Registration Form / Invoice
Ordering by credit card or CompuServe's Software Registration Service
Ordering by check or money order:    To order, send this order form and a check or 
money order to:

Frank A. Pellegrino
1412    Avenue M - Suite 2213
Brooklyn, NY 11230

To print this order form, select    File | Print Topic.    Payments must be in US dollars
drawn on a US bank.    Alternately, you can send international postal money orders in US 
dollars.    For orders outside the US and Canada add an extra    $5 for shipping and 
handling.    Prices below reflect    a $3 shipping and handling charge and a direct order 
discount.    Allow 3-4 weeks shipping.

Disk size: (please circle one) 5.25" 3.5"

Label Wizard    Single Copy        ____        copies at $25 each = ______
Write for information on site license price structure.
Prices guaranteed through August 1994, $30 afterwards.

Total payment = ______

Registered User Information (Name and Company as will appear in the About box)

Name:  ________________________________________ 
Company: _______________________________________

Mailing Address (Name, Company, Address, City, State, Zip, Country)

_________________________________________________
_________________________________________________
_________________________________________________
_________________________________________________

Phone
Day: __(_____)___________________ Evening: __(_____)____________________

Electronic Mail address: _____________________________________________________

Customer Survey
1. How did you hear about Label Wizard 2.2?
___ Friend
___ BBS    ____________________________
___ Other    ____________________________

2. Your computer system:
CPU: _______________________________
RAM: _______________________________
Printer: ______________________________

3. Comments / Suggestions for future 
versions:



Credit Card Orders

To order by MasterCard, Visa, American Express, or Discover, contact the Public (software) 
Library at:

Phone 1-800-2424-PsL or 713-524-6394
FAX, Email or 
Mail

Order Form

Please be sure to include your credit card number and expiration date on all credit card 
orders.
Label Wizard's product number is 11238.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY!

Any questions about the status of the shipment of the order, refunds, registration options, 
product details, technical support, volume discounts, dealer pricing, site licenses, etc, must 
be directed to:

Frank A. Pellegrino
1412    Avenue M - Suite 2213
Brooklyn, NY 11230

or by Email:
Internet: v088mdnl@ubvms.cc.buffalo.edu
CompuServe: 73513,2660

To insure that you get the latest version, PsL will notify us the day of your order and we will 
ship the product directly to you.



PsL Order Form - Label Wizard    #11238
FAX 713-524-6398
Email CompuServe mail to 71355,470 or 

Internet mail to 71355.470@compuserve.com
Mail PsL

P.O. Box 35705
Houston, TX 77235-5705

For orders outside the US and Canada add an extra    $5 for shipping and handling.

Disk size: (please circle one) 5.25" 3.5"

Label Wizard    Single Copy        ____        copies at $30 each = ______
Prices guaranteed through August 1994, $35 afterwards.

Total payment = ______

Registered User Information (Name and Company as will appear in the About box)

Name:  ________________________________________ 
Company: _______________________________________

Mailing Address (Name, Company, Address, City, State, Zip, Country)

_________________________________________________
_________________________________________________
_________________________________________________
_________________________________________________

MasterCard, Visa, American Express, or Discover
Credit Card Information (Card Holder, Card Number, Expiration Date, Signature)

_________________________________________________
_________________________________________________
_________________________________________________
_________________________________________________



CompuServe's Software Registration Service

Enter GO SWREG at the ! prompt and follow the menus.
Label Wizard's registration id is 2264.



Registration Profile

In order to successfully complete this section you must type in your registration 
name, company and number exactly as it was given to you.    The name and company were 
taken off your order form.    If for any reason you cannot get past the Registration Profile with
your information then get in touch with me.

see Obtaining Product Support



Obtaining Product Support 
Product support may be obtained by any of the following: 

US mail address:
Frank A. Pellegrino
1412    Avenue M - Suite 2213
Brooklyn, NY 11230

Electronic mail address:
Internet: v088mdnl@ubvms.cc.buffalo.edu (good until May 1994)
CompuServe: 73513,2660

In all correspondences, please put the name of the program in the subject line for E-
mail and on the envelope for postal mail.    The best way to get in touch with me is through 
E-Mail.

I'd like to hear any opinion or suggestion you have about Label Wizard.    If you want to see 
certain features in the next version, write to me about it.

I'd also like to hear about any bugs you find in the program.    Just fill out the Bug Report 
Form and send it to the address above. 

See also... 
Register Label Wizard



Bug Report Form

Name:  ________________________________________ 
Company: _______________________________________

Mailing Address (Name, Company, Address, City, State, Zip, Country)

_________________________________________________
_________________________________________________
_________________________________________________
_________________________________________________

Phone
Day: __(_____)___________________ Evening: __(_____)____________________

Electronic Mail address: _____________________________________________________

Version of Label Wizard: ______________________

1. Your computer system type and configuration:

2. Bug and how to reproduce it:



About the Author
The author of Label Wizard is Frank A. Pellegrino.    In an effort to do something 

different with his summer vacation (this is last year now), he programmed his entire 
vacation away.    He now holds a B.S in Electrical Engineering and is a graduate student at 
the University of Buffalo.    He will be doing really cool work with his friends Dave and Todd    
this year.    When he is not studying in Buffalo, Frank is back home in his hometown of 
Brooklyn, New York.    In his spare time he enjoys listening to music, writing his own music, 
and programming.    If you attended school with him, he'd be more than happy to receive 
mail from you.    That is if you find this screen.

    Enough about me.    Time to say a little about this program.

Label Wizard is the product of one man, with a man's courage ( you know it).    The 
idea of printing labels is not new.    In fact this program could have ended up as an inflexible 
audio cassette label program (good thing it didn't because I'd probably wouldn't have made 
any money!).    That's how it started out in 1992.    I was just learning how to write programs 
for Windows.    There was this program that I started off trying to improve.    I never did finish 
or release any of it.    Then in 1993, I purchased a better software development kit, which I 
won't mention here, and started on planning to port my older program.    That didn't happen 
because one night, a C++ object oriented generalization of my program popped into my 
head, and is now on your computer.    

I'd like to take this space to thank my parents, and other relatives who have been 
supportive to me over the years.    I'd like to thank my friends for being around.    And I hope 
that I will be able to supply you with future versions of Label Wizard (time permitting).



State University of New York at Buffalo
Buffalo, New York:    The home of the Buffalo Bills (the four time AFC Champions and 

unfortunate four time Super Bowl losers) and famous Buffalo wings (chicken wings to most 
folks out there).



The thing most students in college have found a way around.



Schools Attended
P.S. 186 '77-'83
I.S. 227 '83-'87
Stuyvesant H.S. '87-'90



Music I listen to:

Roger Taylor, Queen, The Beatles, The Cross, John Lennon, Brian May, David Bowie, Led 
Zeppelin, Robert Plant, Frank Zappa, Eric Clapton, The Who, Jimi Hendrix, The Doors, Alice 
Cooper, The Pixies, The Dead Milkmen, and other popular music.



Vito and Anna for supporting the development of version 2.2/2.3.

Beta Testers: Vito, Joe and Anthony

College friends: Big Mike and his blender, Steve and his musicianship, Craig and his hair, 
Jesse and his collection of bones, Mike and his Mei, and more Mike's, Dave, Dave, Chris 
(woohoo), the woohoo girls: Gretchen, Salleigh and Wendy, Todd, Stephanie, Tom (click), 
Stoke (Stroke), Tom, Dean the organizer, Andy the detainee, Raymond, Ray, Morris, Dewey 
and many more I don't remember off hand, you know who you are.    Additional thanks to 
Mary, Jennifer, Lisa, Steve, Taylor, and Dr. D.

Special thanks to Chris Marriot of England who has helped many others like myself through 
the Usenet newsgroups.

Big thanks to all of those professors and administrators at U.B. who have helped me in any 
way.



Band: no official name, no singer, just music:    Vito, Joe and myself.
Band away from home: music and lyrics, all for fun:    Steve, sometimes Mike, and myself.
Band on the Run:    That's Wings silly.



Vito

Vito is my cousin and he plays the guitar and bass.    Vito would like the band's name to be 
Excalibur, the same name he used for a previous band of his (10+ years ago).



Joe

Joe is my brother and he plays the drums.    He was attending the College of Staten Island.    
Joe plans on moving down to Florida and going to school there.



Frank

Frank (me) plays the guitar and bass.    Frank is currently playing bass with the band.    This 
will change if they finally get a bassist/singer for the band.    All the band members write the 
music, remember there are no lyrics.    Frank would like the band's name to be Torque.    With 
his band away from home Frank writes the music and Steve the lyrics.



Roger Taylor

Roger Taylor is the drummer and chief background vocalist of Queen.    He is 
responsible for writing such songs as 'I'm In Love With My Car' and 'Radio Ga Ga' and most 
notably singing the high 'me' part in 'Bohemian Rhapsody'.    In the early eighties he 
released two solo albums that are impossible to find (they haven't been released on CD yet):
'Fun In Space' and 'Strange Frontier'.    I think they are two great albums.    Roger performed 
on most, if not all, of the instruments on those two albums.    He also sang of course.    Most 
people say he sounds a bit like Rod Stewart.

In the late eighties he formed a side band called The Cross, and was the lead singer 
and guitarist.    They released three CD's before losing their record contract.    I guess there 
wasn't enough public interest in his solo material.    I luckily obtained those three CD's.    
Soon he should be releasing a new solo album called 'Happiness ?'.    Depending on 
distribution, his album may make it to the US.    Hopefully the promotion for this album is 
better than his previous albums.    Most likely not, and once again the US will have no clue 
who Roger Taylor is... unless they all read this.

As of this writing, he has released the first single from his forthcoming album.    The 
single is 'Nazis 1994', a song against the neo-Nazi movement.    It is not getting any airplay 
in England due to its political nature.      The song placed 22nd in the music charts the first 
week. 






